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Question No : 1

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based
network. You have changed some data in the worksheet of the company. You are
submitting the sell workbook of the company to the Administrator of the company for
comments. Now, you want to merge input that you receive into a copy of that workbook,
including the changes and comments that you want to keep. For this purpose, it is required
to access and use the stored change history. Which of the following will you use to
accomplish the task?

A. Slicer-enabled highlighting
B. Onscreen highlighting

C. Reviewing of changes

D. History tracking

Answer: C

Explanation:

The following ways are provided by Excel to access and use the stored change history:

1. Onscreen highlighting: It is used when a workbook does not contain many changes and
a user

wants to see all changes at a glance.

2. History tracking: It is used when a workbook has many changes and a user wants to
investigate what occurred in a series of changes.

3. Reviewing of changes: It is used when a user is evaluating comments from other users.
Answer option A is incorrect. This is an invalid answer option.

Question No : 2 HOTSPOT

You work as an Office Assistant for Blue well Inc. The company has a Windows-based
network. You want to create a VBA procedure for the open event of a workbook. You are
required to set the security level temporarily for enabling all macros. Mark the option that
you will choose first to accomplish the task.
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Question No : 3

Rick works as an Office Assistant for Tech Perfect Inc. The company has a Windows-
based network.

Rick has to perform the following tasks:

Summarize large amounts of data. Analyze numeric data.

Answer unexpected questions about data.

Which of the following actions will Rick take to accomplish the task?
A. He will create the accounting template.

B. He will use stand-alone slicers.

C. He will create a PivotTable report.
D. He will configure form controls.

Answer: C
Explanation:

A PivotTable report is used to summarize large amounts of data, to analyze numerical
data, and to answer unexpected questions about data.

Answer option B is incorrect. Stand-alone slicers are referenced from Online Analytical
Processing (OLAP) Cube functions. These stand-alone slicers can be connected with any
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PivotTable in future.

They can be added by using the slicer button on the Ribbon. They need to be manually
linked into grids as required.

Answer option D is incorrect. A form control is an original control that is compatible with old
versions of Excel, beginning with Excel version 5. 0. It is designed for use on XLM macro
sheets. It can be used when a user wants to simply interact with cell data without using
VBA code and when he wants to add controls to chart sheets. By using form controls, the
user can run macros. He can attach an existing macro to a control, or write or record a new
macro. These controls cannot be added to UserForms, used to control events, or modified
to run Web scripts on Web pages.

Answer option A is incorrect. The accounting template is used for numbering months of a
financial year to period numbering. It is used to compare month to month, actual v budget,
guarter to quarter, year to year variances. It is the initial point for other reports that need the
use of months.

Question No : 4

You work as an Office Assistant for Tech Perfect Inc. You are working in the spreadsheet
of the

company's high selling products. You want to find out the matching values. You get an
unexpected error that when you attempt to look up or match a lookup_value within an
array, Excel is not able to recognize the matching value. Which of the following steps will
you take to resolve the problem? Each correct answer represents a part of the solution.
Choose all that apply.

A. Remove the unseen spaces at the start or end of the first Macro cell.

B. Delete the column having the TRIM function.

C. Copy the contents of the new column and paste them on the top of the original column
by using paste > special > values sequence.

D. Create a new column subsequent to the one with the additional spaces in it.

E. Use the TRIM function in the new column.

Answer: B,C,D,E
Explanation:

In this situation, you will take the following steps:

1. Create a new column subsequent to the one with the additional spaces in it.
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2. Use the TRIM function in the new column to get rid of extra spaces.

3. Copy the contents of the new column and paste them on the top of the original column
by using paste > special > values sequence.

4. Delete the column having the TRIM function.

Answer option A is incorrect. This is an invalid answer option.

Question No : 5

You work as an Office Assistant for Dreams Unlimited Inc. You use Microsoft Excel 2013
for creating various types of reports. You have created a report in the format given below:

o, B Lo o
1 |%ales Person ~ | Bxceeded Jan Quota| | Bxceeded Feb Quotal ~ |EBxceeded Mar Quota [~]
2 Mark Ves ko o
3 |Sarah ¥es s Mo
4 |David ¥es res Ve
5 Satha ko =T =T
& Formula Description (result)

Counts how many sales people exceeded both theirJanuary and February Quota

In the A7 cell, you are required to put a formula so that it can fulfill the description provided
in the B7 cell.

Which of the following formulas will provide the required result?

A. COUNTIF(B2:C5,"=Yes")

B. COUNTIFS(B2:C5,"=Yes")

C. COUNTIF(B2:B5,"=Yes",C2:C5,"=Yes")
D. COUNTIFS(B2:B5,"=Yes",C2:C5,"=Yes")

Answer: D
Explanation:

In order to get the required result, you will have to insert the following formula in the B7 cell:
COUNTIFS(B2:B5,"=Yes",C2:C5,"=Yes")

Only Sarah and David have exceeded their January and February quotas, therefore the
formula will provide 2 as the result.

Answer option C is incorrect. The COUNTIF function of Excel does not support multiple
criteria.

Answer options A and B are incorrect. This formula will count all the cells that have the
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value

"Yes" in the range B2:C5. As multiple criteria are not applied in the formula, it will provide 6
as the result.

In the A7 cell, you are required to put a formula so that it can fulfill the description provided
in the B7 cell.

Which of the following formulas will provide the required result?

A. COUNTIF(B2:C5,"=Yes")

B. COUNTIFS(B2:C5,"=Yes")

C. COUNTIF(B2:B5,"=Yes",C2:C5,"=Yes")
D. COUNTIFS(B2:B5,"=Yes",C2:C5,"=Yes")

Answer: D

In order to get the required result, you will have to insert the following formula in the B7 cell:
COUNTIFS(B2:B5,"=Yes",C2:C5,"=Yes")

Only Sarah and David have exceeded their January and February quotas, therefore the
formula will provide 2 as the result.

Answer option C is incorrect. The COUNTIF function of Excel does not support multiple
criteria.

Answer options A and B are incorrect. This formula will count all the cells that have the
value

"Yes" in the range B2:C5. As multiple criteria are not applied in the formula, it will provide 6
as

the result.

Question No : 6
You work as an Office Assistant for Tech Perfect Inc. The company has a Windows-based

network. You are creating a business report by using. Microsoft Excel 2013. You have
arranged sales data as shown below:
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FES B i D E
1 Target Achieved (In USS)
2 # Mame 2008 2009 2010
3 1 Rick 46,300 78,000 a2,000
q 2 Mark 42,500 63,500 110,500
2 3 Adam afb, 120 29,200 99,700
b 4 Ada 47,200 61,500 93,900
i 5 Andy 43,000 69,200 110,250
o & David 47,000 71,100 111,000

You want to provide pictorial representation of the trend of the sales data in front of each
row.

Which of the following actions will you take to accomplish the task with the least amount of
administrative burden?

A. Use stand-alone slicers.

B. Configure form controls.

C. Create sparklines.
D. Create a PivotTable report.

Answer: C
Explanation:

% Name 2008 2009 2010 Trends

1 Rick dg, 300 T8,000 gzagon|

| 2 Mark 42,500 63,500 110,500 @ ——
3 Adam 56,120 59,200 99,700 ="
| 4 Ada 47,200 61,500 ke ] R T——
5 Andy 43,000 69,200 110,250 ___—
‘6 David 47.000 71.100 111.000 ——
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In order to accomplish the task with the least amount of administrative burden, use
sparklines.

Sparklines, introduced in Microsoft Office 2013, are tiny charts that can fit in a cell. The
sparklines can be used to show trends in a small amount of space. The sparklines visually
summarize trends alongside data.
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The sparklines can be added through the Insert tab.

Answer option A is incorrect. Stand-alone slicers are referenced from Online Analytical
Processing (OLAP) Cube functions. These stand-alone slicers can be connected with any
PivotTable in future.

They can be added by using the slicer button on the Ribbon. They need to be manually
linked into grids as required.

Answer option B is incorrect. A form control is an original control that is compatible with old
versions of Excel, beginning with Excel version 5. 0. It is designed for use on XLM macro
sheets. It can be used when a user wants to simply interact with cell data without using
VBA code and when he wants to add controls to chart sheets. By using form controls, the
user can run macros. He can attach an existing macro to a control, or write or record a new
macro. These controls cannot be added to UserForms, used to control events, or modified
to run Web scripts on Web pages.

Answer option D is incorrect. A PivotTable report is used to summarize large amounts of
data, to

analyze numerical data, and to answer unexpected questions about data.

Question No : 7

You work as an Office Assistant for Tech Perfect Inc. You are working in the spreadsheet
of the

company's high selling products. You are trying to intersect two ranges that do not intersect
each

other. Which of the following errors will be occurred in this situation?

A. #VALUE!
B. #NAME?
C. #NULL!
D. #DIV/0!

Answer: C
Explanation:

The #NULL! error is produced by Excel when a user attempts to intersect two ranges that
do not

intersect each other. This error can be resolved by reviewing the formula and then

either by changing the variables to ensure that the user is getting a valid intersection or by
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using the Excel Iferror function to identify a null range and take the required action.
Answer option D is incorrect. Excel #DIV/0! is produced when a formula attempts to divide
by zero and a division by zero produces infinity that cannot be represented by a
spreadsheet value. This error can be corrected or overcome by using the Excel IF function
to identify a possible division by zero and produce an alternative result.

Answer option A is incorrect. The #VALUE! Excel formula error occurs when any of the
variables in a formula is of the wrong type. To correct this error, it is required to check each
individual part of the formula to make sure that the correct argument types are used. If the
function contains nested functions, the best way is to copy each of the arguments into a
separate cell to check what they evaluate to. If the formula contains a number of terms,
break down each term further to find out its components, until the source of the error is
found.

Answer option B is incorrect. The #NAME? error occurs when Excel encounters text in a
formula and tries to interpret that text as a reference, a named range, or a function name
but is not able to recognize the text as any of these. The best way to approach the
#NAME?

Excel function error is to check the correct spelling of the function names, references, and
named

ranges and to check that the variables used as text values are entered in double quotes. If
the

formula contains nested functions, it is required to check the results of these individually,
until

the source of the error is identified.

Question No : 8

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based
network. You want to filter data in a PivotTable report without opening drop-down lists to
find the items that you want to filter. For this purpose, you are using a slicer. After filtering
the data, you want to delete the slicer. Which of the following steps can you take to
accomplish the task?

Each correct answer represents a complete solution. Choose all that apply.

A. Click the slicer that you want to delete on the Options tab in the Slicer type group.

B. Click the Macro setting, and then delete the slicer from the Macro-enabled slicers list.
C. Click the slicer, and then press Delete.

D. Right-click the slicer, and then click Remove <Name of slicer>.
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Answer: C,D
Explanation:

Take one of the following steps to delete a slicer:

1. Right-click the slicer, and then click Remove <Name of slicer>.

2. Click the slicer, and then press Delete.

Answer options B and A are incorrect. These are invalid answer options.

Question No : 9

Which of the following is used to display a trend based on adjacent data in a clear and
compact

graphical representation by taking up a small amount of space?

A. Trendline
B. Line chart
C. Sparkline
D. Backstage view

Answer: C
Explanation:

A sparkline is defined as a tiny chart in the background of a cell. Unlike charts on an Excel
Worksheet, sparklines are not objects. It is used because data presented in a row or
column is

useful, but patterns can be hard to spot at a glance. It is used to display a trend based on
adjacent data in a clear and compact graphical representation by taking up a small amount
of space.

The benefit of using the sparklines is that these can be printed when a user prints a
worksheet

that contains them. This feature is not available in charts.

Answer option D is incorrect. The Microsoft Office Backstage view is used to replace the
traditional file menu with a new approach that uses In and Out features for efficiency. The
improved Ribbon enables users to access their preferred commands rapidly and create
custom tabs to personalize the way they work.

Answer option A is incorrect. A trendline is defined in Excel 2013. It is a data visualization
tool

to display the trend of a particular data range.
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It is used to show the slope of data points in a chart. There are various types of trendlines,
such as linear trendlines, exponential trendlines, and linear forecast trendlines.

Answer option B is incorrect. Excel provides a column chart facility to display data that is
arranged in columns or rows on a worksheet. Line charts are used to display continuous
data over time, set against a common scale. In a line chart, category data is distributed
along the

horizontal axis, and all value data is distributed along the vertical axis. Line charts are ideal
for showing trends in data at equal intervals.

First Quarter Sale
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54 060000 4
$3.500,00
$3,000000
$2 800,00
j $7.000.00
£1,300,00 4
$1,000.00
$500.00 “arak
$0.00
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A line chart should be used where category labels are text, and are representing evenly
spaced
Values such as months, quarters, or years.

Question No : 10

You work as an Office Assistant for Media Perfect Inc. You have created a spreadsheet in
Excel 2013 and shared it with the other employees of the company. You select the Encrypt
with Password option as a protection measure for the document you are sharing. Now, you
have to specify a password in the Password box in the Encrypt Document dialog box
appeared for editing the document. But you have forgotten the password. What will happen
in this situation?

A. You will use a new password.
B. You will ask Microsoft to retrieve the password.
C. You will fetch the password from the list in which you have saved it.
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D. You will create a new document.

Answer: C
Explanation:

The various Protect Workbook options are as follows:

1. Mark as Final: This option is used to make the document read-only. When a spreadsheet
is marked as final, various options such as typing, editing commands, and proofing marks
are disabled or turned off and the spreadsheet becomes read-only. This command helps a
user to communicate that he is sharing a completed version of a spreadsheet. This
command also prevents reviewers or readers from making inadvertent modifications to the
spreadsheet.

2. Encrypt with Password: When a user selects the Encrypt with Password option, the
Encrypt Document dialog box appears. In the Password box, it is required to specify a
password. Microsoft is not able to retrieve lost or forgotten passwords, so it is necessary for
a user to keep a list of passwords and corresponding file names in a safe place.

3. Protect Current Sheet: This option is used to select password protection and permit or
prohibit

other users to select, format, insert, delete, sort, or edit areas of the spreadsheet. This
option

protects the worksheet and locked cells.

4. Protect Workbook Structure: This option is used to select password protection and select
options to prevent users from changing, moving, and deleting important data. This feature
enables a user to protect the structure of the worksheet.

5. Restrict Permission by People: This option works on the basis of Window Rights
Management to restrict permissions. A user is required to use a Windows Live ID or a
Microsoft Windows account to restrict permissions. These permissions can be applied via a
template that is used by

the organization in which the user is working. These permissions can also be added by
clicking

Restrict Access.

6. Add a Digital Signature: This option is used to add a visible or invisible digital signature.
It

authenticates digital information such as documents, e-mail messages, and macros by
using computer cryptography. These signatures are created by specifying a signature or by
using an image of a signature for establishing authenticity, integrity, and non-repudiation.
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Answer option D is incorrect. You can create a new document with the same details but it
will

increase the overhead and is a very time consuming process.

Answer option D is incorrect. You can create a new document with the same details but it
will

increase the overhead and is a very time consuming process.

Question No : 11
Rick works as a Sales Manager for Tech Perfect Inc. He is creating a report in Excel 2013.

He has entered data in five worksheets in a workbook. He wants to enter a disclaimer
message in the Al cell of each sheet in the workbook as shown in the image given below:
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A B = ]

Disclaimer-This documeni r;l

Sales Reﬁah\\hch Perfect Inc.

m

%]

3

5 Mark $2.000.00 §2,750.00 $3,700.00 $8, 450 00
& David 100000 57,200, 00 $2 900,00 35,800.00
7 Madah  $1,75000 $2,350.00 $3,200.00 $7.300.00
9 Sarah $2,200.00 $2,750.00 $3,810.00 $8,740.00
9 Sasha £3,100.00 $2,90000 $4,150.00 £10,150.00
10" Total 2809200

Which of the following is the easiest way to accomplish the task?

A. Write a disclaimer message in the Al cell of the first sheet.

Copy the disclaimer message and paste it on the remaining sheets.

B. Write a disclaimer message in the Al cell of the first sheet.

In the other sheets, insert a formula that points to the Al cell of the first worksheet.
C. Select all the five sheets. Click the first sheet.

Write a disclaimer message in the Al cell of the active sheet.

D. Select all the five sheets.

Write a disclaimer message in the Al cell of the active sheet.

Answer: D
Explanation:

In order to accomplish the task, Rick should take the following steps: Select all the five
sheets.

Write a disclaimer message in the Al cell of the active sheet.

Grouping of sheets is a feature provided in Microsoft Office Excel 2013. Selecting more
than one sheet groups those sheets. When multiple sheets are grouped, data that a user
enters or edits in the active sheet is reflected in all sheets in the group. To select all sheets,
right-click a sheet

tab, and then click Select All Sheets on the shortcut menu.
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Users can select multiple sheets by holding the Ctrl key while clicking the sheets.
Answer option C is incorrect. Clicking the first sheet after selecting all sheets will ungroup
the

sheets and the message will only get inserted in the first sheet.

Answer options B and A are incorrect. Both these options will work, but Rick will have to
work more than required. Grouping sheets is a better option to work simultaneously on
multiple sheets.

Users can select multiple sheets by holding the Ctrl key while clicking the sheets.
Answer option C is incorrect. Clicking the first sheet after selecting all sheets will ungroup
the

sheets and the message will only get inserted in the first sheet.

Answer options B and A are incorrect. Both these options will work, but Rick will have to
work more than required. Grouping sheets is a better option to work simultaneously on
multiple sheets.

Question No : 12

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based
network. You want to filter data in a PivotTable report without opening drop-down lists to
find the items that you want to filter. For this purpose, you are using a slicer. After filtering
the data, you want to disconnect the slicer. You have clicked anywhere in the PivotTable
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report. Which of the following steps will you take next to accomplish the task?

Each correct answer represents a part of the solution. Choose all that apply.

A. Clear the check box of any PivotTable fields for which you want to disconnect a slicer.
B. Right-click the slicer, and then click Remove <Name of slicer>.

C. Click the Insert Slicer arrow, and then click Slicer Connections on the Options tab in the
Sort

& Filter group.

D. Click the slicer, and then press Delete.

Answer: A,C

Question No : 13 HOTSPOT

You work as a Sales Manager for Rainbow Inc. You are working on a report in a worksheet
in Excel 2013. You want to insert flow-chart in the sheet. Mark the option that you will
choose to insert flow- chart symbols in the report. Explanation: In order to accomplish the
task, you will have to choose the Shapes option. Shapes are simple objects provided by
Microsoft Office to add them to a document. A single shape or combined multiple shapes
can be inserted in the document. The Office includes simple shapes, such as lines, basic
geometric shapes, arrows, equation shapes, flowchart

shapes, stars, banners, and callouts. Users can add text, bullets, numbering, and Quick
Styles to

these shapes after inserting them in the document. Take the following steps to add a shape
ina

document:

Harne Insert Page Layout Formulas Data Rewiew Wie

]4’_ El@ LY shapes~ e Line « paly Area - A tine _'I @
Wl FE] B = =
s I—I - T2 smartart ﬁ @B Pie v | Seatter v M= Column | == -
PiwvotTable Table Ficture  Clip ... Column = : Slicer Hyperlink
- art e+ Screenshot v - = Bar v uother Charts = | [0 win/Loss
Tables Tllustrations Chatts X Sparklines Filter Litiks
Answer:
Home Insert Page Layout Formulas Data Rewiew Wi
G El@ L shapes~| e Line « paly Area - A tine (= a
(It wall BE '.'_J:— ] il i =l :
4| SmarkArt ab ric - EScatter' Ble Column — p—
PiwotTable Tahle Picture Clip . Calurnn = 1 Slicer Hyperlink
- art @k Screenshot v - = Bar - UOther Charts = | [0 wingloss
Tables Tlustrations Chatts X Sparklines Filter Litiks
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1. Click on the Shapes option in the llustrations group on the Insert tab. This will open the list of shapes available in Microsoft Office.

Insert Page La
18] clip &t
|I—| JJ Shapes *
N

Tlustrations

2. Choose the required shape from the list.

HOOADOv TS~ "
[BESINNE N

Block Arrows
PSPPI
& dvnpD AN
Loa

Equation Shapes

=R ==

Flowchart
O0<0Onoldecayd
COCNVP E 6§ AVED
aB@o

Stars and Banners
MRTRCREEHE8S8
TR ) T IR

Callouts
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Question No : 14

You work as an Office Assistant for Tech Tree Inc. You have created a report in a
workbook in

Microsoft Excel 2013. You want to export XMLdata to your Excel 2013 worksheet. On
exporting the XML data, the following error message appears:

"XML MAPS IN MY WORKBOOK ARE NOT EXPORTABLE"

Which of the following are the reasons that are causing the above error? Each correct
answer

represents a complete solution. Choose all that apply.

A. The maxoccurs attribute is not equal to 1.
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B. The relationship of the mapped element with other elements is not preserved.

C. The element is a recursive structure.

D. The XML map associated with this XML table contains one or more required elements
that are not mapped to the XML table.

Answer: A,B
Explanation:

The various issues with exporting XML data are as follows:

1. MAP CAN BE EXPORTED BUT SOME REQUIRED ELEMENTS ARE NOT MAPPED:
This error occurs under the following situations:

The XML map associated with this XML table contains one or more required elements that
are not mapped to the XML table. The element is a recursive structure.

The XML table contains a variety of mixed content.

2. EXCEL CANNOT SAVE THE WORKBOOK BECAUSE IT DOES NOT CONTAIN ANY
XML MAPPINGS: Excel cannot save the user's workbook in the XML Data file unless one
or more mapped ranges are created.

3. XML MAPS IN MY WORKBOOK ARE NOT EXPORTABLE: An XML mapping cannot be
exported if the relationship of the mapped element with other elements is not preserved
due to the following reasons:

The mapped element's schema definition is contained within a sequence with the following
attributes:

The maxoccurs attribute is not equal to 1.

The sequence has more than one direct child element defined or has an extra compositor
as a direct child.

Nonrepeating sibling elements with the same repeating parent element are mapped to
dissimilar

XML tables.

Various repeating elements are mapped to the same XML table and the recurrence is not
defined by an ancestor element.

Child elements from various parents are mapped to the same XML table.

XML schema constructs a list of lists, denormalized data, or a choice construct.

Question No : 15

You work as an Office Assistant for Media Perfect Inc. You are creating a report in
Microsoft Excel 2013. The report worksheet will include the sales made by all the sales
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managers in the month of January.

A E

1 Sales Report

2

3 - -
4 David $1,000.00
5 Mariah $1,700.00
& Mark $2,500.00
7| Sarah $2,200.00
g  Sazsha $3,100.00
?  Total $10,500.00,

In the worksheet, you are required to place a pictorial representation displaying the
percentage of

total sales made by each sales manager in January. Which of the following charts will you
use to

accomplish the task?

A. Bar
B. Line
C. Column
D. Pie

Answer: D
Explanation:

In order to accomplish the task, you will have to insert a pie chart in the worksheet. Excel
provides a pie chart facility to display data that is arranged in one column or row on a

worksheet.
Pie charts display the size of items in one data series, proportional to the sum of the items.

Question No : 16 HOTSPOT
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You work as an Office Assistant for Blue Well Inc. The company has a Windows-based
network. You want to insert a signature line that specifies the individual who must sign.

Mark the option that you will choose to accomplish the task.

IEII 0 .j IJ\‘-I |+ Microsoft Excel = B 52
Home Insert Mews Tab Page Layout Formulas Data Reviews Wi Developer Team () e
- Foa B =1 - [ h i - - L
i 5::_-.. - EZ ) ficLine - M | L @ AF] E Q
J el = @ |- =] ua
PivotTable Table Picture Cllp o Column . Sparklines  Slicer | Hyperlink  Text  Header Symbals
- At EEET Spear- - T ) Box & Footer b
=Tl Tlustrations Charts [F} Fiiler Links Text
a1 - 5| ¥
Answer:
IEII 0 .j I_l\"l |+ Microsoft Excel = =52
Home Insert Mews Tab Page Layout Formulas Data Reviews Wi Developer Team () e
- Foa - [ h i - - L
| : bl E!lﬁl J #l Line - by = L @ = 74
3 =l &®rie v |- La
PivotTable Table Picture Cllp o Column . Sparklines  Slicer | Hyperlink  Text  Header == Symbols
- fet EEET - Bpear- - T ) Box & Footer
=Tl Tlustrations Charts [F} Fiiler Links Text
a1 - 5| ¥

Explanation:

The following figure shows the option used to insert a signature line that specifies the

individual
who must sign.

& QEl &= Microsaft Excel _ o B 22
File Horne Insert Mew Tak Page Layout Formulas Data Rewvigw Wiew Develdper Team & e
= T L T
(2 & EEEY ML = Q@ H2Y o
= 2 & Fie - ___.__, : B
FivotTable  Table | Picture Clip .. Column Sparklines  Slicer | Hyperlink | Text  Header Swmahnl l
- A GET } Bar 'J' I Box & Footer| Microsoft Office Sjgnature Lir
ST e Tllustrations Charts Filter Links Text | Add Signature Sefices..
Al - I | v

C:\Documents and Settings\Administrator\Desktop\1.JPG

Question No : 17
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You work as an Office Assistant for Tech Perfect Inc. You are working in a spreadsheet as
shown below:

You want to use Excel Transpose Function for copying the contents of cells B1:B3 into
cells A5:C5.

You simply type '=TRANSPOSE( B1:B3)' into the cells A5:C5. It displays the Excel
#VALUE! error message because the cells are working independently and the function will
not work for each individual cell. Therefore, it is required to make the cells A5:C5 work
together as an ARRAY. For this purpose, you are required to use an array formula. Which
of the following steps will you take to input Excel array formulas in the spreadsheet?

Each correct answer represents a part of the solution. Choose all that apply.

A. Type the array formula into the first cell.

B. Highlight the range of cells that you want to use as an input in his array formula.
C. Press CTRL-SHIFT-Tab to remove the error message.

D. Press CTRL-SHIFT-Enter.

Answer: A,B,D
Explanation:

The following steps are taken to input Excel array formulas:

1. Highlight the range of cells that a user wants to use as an input in his array formula.
2. Type the array formula into the first cell or make this cell editable by pressing F2 or
clicking

in the formula bar if a user has already specified a value into the first cell.

3. Press CTRL-SHIFT-Enter.
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Answer option C is incorrect. This is an invalid answer option.

Question No : 18

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based
network. You want to get the trend of the Business data range. For this purpose, you want
to use trendlines in the chart. Which of the following steps will you take to apply the
trendlines in the chart?

Each correct answer represents a part of the solution. Choose all that apply.

A. Clear the check box of any Trendline fields to disconnect a slicer.

B. Select the type that you want from Trendline options.

C. Click the Insert Trendline arrow, and then click Trendline Connections on the Options
tab in the Sort & Filter group.

D. Select a chart and then navigate to the Chart Tools Layout tab.

Answer: B,D

Question No : 19

You work as an Office Assistant for Tech Perfect Inc. You are working in a spreadsheet.
You observe that while trying to look up or match a lookup_value within an array, Excel is
not able to recognize the matching value. Which of the following are the reasons that are
causing the above problem?

Each correct answer represents a complete solution. Choose all that apply.

A. The lookup_value or the array you are searching resides in a cell containing unseen
spaces at

the start or end of that cell.

B. The contents of the cells that are being compared may have different data types.

C. Excel is trying to reference an invalid cell.

D. You are inserting a new column, next to a column that is already formatted as text.

Answer: A,B
Explanation:
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The Failure to Look Up Values in Excel error occurs when a user gets an unexpected error
while trying to look up or match a lookup_value within an array and Excel is not able to
recognize the matching value. If the lookup_value or the array the user is searching resides
in a cell, the user can have unseen spaces at the start or end of that cell. This will create
the situation where the contents of the two cells that the user is comparing look the same
but extra spaces in one of the cells cause the cells to have slightly different content. The
other reason is that the contents of the cells that are being compared may have different
data types. Answer option C is incorrect. The Lookup Function Won't Copy Down to Other
Rows error occurs when a user uses a function in one cell and it works perfectly but when
he attempts to copy the function down to other rows, he gets the #REF error. The #REF!
error arises when Excel tries to reference an invalid cell. This error occurs if the user has
referenced an entire worksheet by clicking on the grey square at the top left of the
worksheet. For Excel, this reference range is 1 to 1048576. Since the references are
Relative References, Excel automatically increases the row references when this cell is
copied down to other rows in the spreadsheet.

Answer option D is incorrect. The Excel Won't Calculate My Function error occurs when a
user types in a function and presses Enter, the cell shows the function as the user typed it,
instead of returning the function's value. The reason that causes this problem is that the
cells containing the formula are formatted as 'text' instead of the ‘General’ type. This
happens when the user inserts a new column, next to a column that is already formatted as
text due to which the new column inherits the formatting of the adjacent column.

Question No : 20 DRAG DROP

You work as a Help Desk Technician for Net Perfect Inc. You use Excel 2013 to create
different

reports for your company. Drag and drop the appropriate methods for efficient data entry in
front

of their descriptions.
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Description

Method

The first value in a recognized series is entered in a cell. By
dragging the fill handle extends the series.

PlaceHolder

Choosing this option by right-clicking the cell, will show the
existing values in the cell's column. Clicking one of the values will
fill the cell with the entry clicked.

PlaceHolder

Select the range of cells and type in the active cell. Using this
option will fill the entire range with the same value that has been

typed.

PlaceHolder

The first few letters is entered in a cell, the similar entry in the
column is suggested by Excel. Press the Enter key to complete the
series.

PlaceHolder

The first two values in a series are entered in two consecutive
cells. By selecting both the cell and dragging the selection through
the fill handle extends the series.

PlaceHolder

— Data Entry Methods Available in Excel 2007

Wwww.ensurepass.com

AutoFill Fillseries AutoComplete Pick from Drop-down List Ctrl+Enter
1 2 g 4 3
Answer:
Description Method
The first value in a recognized series is entered in a cell. By I_F‘I_ _1 = :.T 1
dragging the fill handle extends the series. L 1
Choosing this option by right-clicking the cell, will show the |_F‘._ = _1e?l
existing values in the cell’'s column. Clicking one of the values will | P
fill the cell with the entry clicked.
Select the range of cells and type in the active cell. Using this = —
option will fill the entire range with the same value that has been I_Pl_‘_ B el
typed.
The first few letters is entered in a cell, the similar entry in the —
column is suggested by Excel. Press the Enter key to complete the L Pl I,
series. -0 -~
The first two values in a series are entered in two consecutive —_—
cells. By selecting both the cell and dragging the selection through PL 2 er b
the fill handle extends the series. | - === a
— Data Entry Methods Available in Excel 2007
AutoFill. FillSeries AutoComplete Pick from Drop-down List Ctrl+Enter
— mm wy e — — oy
. [ LR ) o]
Explanation:
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